Operation Manual
Series D*FB / D*1FT with Integrated Electronics

D*FB Design ≥ 12
D*1FT Design ≥ 40

Proportional Directional Control Valve
Note

This document and other information from Parker-Hannifin Corporation, its subsidiaries and authorized distributors provide product or system options for further investigation by users having technical expertise.

The user, through its own analysis and testing, is solely responsible for making the final selection of the system and components and assuring that all performance, endurance, maintenance, safety and warning requirements of the application are met. The user must analyze all aspects of the application, follow applicable industry standards, and follow the information concerning the product in the current product catalog and in any other materials provided from Parker or its subsidiaries or authorized distributors.

To the extent that Parker or its subsidiaries or authorized distributors provide component or system options based upon data or specifications provided by the user, the user is responsible for determining that such data and specifications are suitable and sufficient for all applications and reasonably foreseeable uses of the components or systems.
# Chapter 1. Introduction
- Order Code D*FB
- Order Code D*1FT
- Name Plate Example
- Block Diagram of Integral Electronics
- Characteristics of Valve Driver
- Technical Data
- Signal Flow Diagram

# Chapter 2. Safety Instructions
- Symbols
- Marking, Name Plates
- Work at the Valve

# Chapter 3. Important Details
- Intended Usage
- Common Instructions
- Liability
- Storage

# Chapter 4. Mounting / Installation
- Scope of Supply
- Mounting
- Operation Limits
- Pressure Fluids
- Electrical Connection
- Electrical Interfacing

# Chapter 5. Operation Instructions
- ProPxD parameterizing software
- Screenshot
- Hardware requirements
- Cable Specification
- Parametrizing connection
- Parametrizing cable
- Program Installation
- Software Operating
- Parameter overview for basic mode
- Individual Description of Basis-Parameters
- Parameter overview for expert mode
- Individual Description of Expert Parameters
- Error messages
- Air Bleeding of Hydraulic System
- Filter
- Flushing

# Chapter 6. Maintenance

# Chapter 7. Trouble Shooting

# Chapter 8. Accessories / Spare Parts
- Accessories
- Spare Parts
1. Introduction

Ordering Code D*FB

<table>
<thead>
<tr>
<th>Code</th>
<th>Nominal size</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>NG06 / CETOP 3</td>
</tr>
<tr>
<td>3</td>
<td>NG10 / CETOP 5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Code</th>
<th>Design</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>a 0 b</td>
</tr>
<tr>
<td>E</td>
<td>a 0</td>
</tr>
<tr>
<td>K</td>
<td>0 b</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Code</th>
<th>Command signal</th>
<th>Function</th>
<th>Connection</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>F0</td>
<td>0...+/-10V</td>
<td>0...+10V &gt; P-A</td>
<td>6 + PE</td>
<td>Pot.-supply</td>
</tr>
<tr>
<td>S0</td>
<td>4...20mA</td>
<td>12...20mA &gt; P-A</td>
<td>6 + PE</td>
<td>–</td>
</tr>
<tr>
<td>W5</td>
<td>0...+/-10V</td>
<td>0...+10V &gt; P-A</td>
<td>11 + PE</td>
<td>Pot.-supply &amp; command preset channel</td>
</tr>
<tr>
<td></td>
<td>4...20mA</td>
<td>12...20mA &gt; P-A</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1) Factory set +/-10V
Ordering Code D*1FT

- **D**: Direct. control valve
- **1**: NG06 pilot
- **F**: Integ. electronics
- **T**: Flow
- **C**: Spool position
- **N**: Seal NBR
- **Option**: (other seal compound on request)
- **Valve accessories**: Option
- **Design series**: Option

### Nominal size

<table>
<thead>
<tr>
<th>Code</th>
<th>Nominal size</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>NG10 / CETOP05</td>
</tr>
<tr>
<td>4</td>
<td>NG16 / CETOP07</td>
</tr>
<tr>
<td>9 *</td>
<td>NG25 / CETOP08</td>
</tr>
</tbody>
</table>

* with enlarged connections Ø 32 mm

### Spool type

<table>
<thead>
<tr>
<th>Code</th>
<th>Spool type</th>
</tr>
</thead>
<tbody>
<tr>
<td>E01</td>
<td>A B</td>
</tr>
<tr>
<td>E02</td>
<td>P T</td>
</tr>
<tr>
<td>B31</td>
<td>Q_B = Q_A /2</td>
</tr>
<tr>
<td>B32</td>
<td>Q_B = Q_A /2</td>
</tr>
</tbody>
</table>

### Flow [l/min] at Δp = 5bar per metering edge

<table>
<thead>
<tr>
<th>Code</th>
<th>Flow [l/min]</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>75</td>
</tr>
<tr>
<td>F</td>
<td>200</td>
</tr>
<tr>
<td>H</td>
<td>400</td>
</tr>
</tbody>
</table>

### Inlet Drain

<table>
<thead>
<tr>
<th>Code</th>
<th>Inlet</th>
<th>Drain</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>internal</td>
<td>external</td>
</tr>
<tr>
<td>2</td>
<td>external</td>
<td>external</td>
</tr>
<tr>
<td>4</td>
<td>internal</td>
<td>internal</td>
</tr>
<tr>
<td>5</td>
<td>external</td>
<td>internal</td>
</tr>
</tbody>
</table>

### Command signal

<table>
<thead>
<tr>
<th>Code</th>
<th>Function</th>
<th>Connection</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>F0</td>
<td>0...±10V</td>
<td>0...+10V &gt; P-B</td>
<td>6 + PE</td>
</tr>
<tr>
<td>M0</td>
<td>0...±10V</td>
<td>0...+10V &gt; P-A</td>
<td>6 + PE</td>
</tr>
<tr>
<td>G0</td>
<td>4...20mA</td>
<td>12...20mA &gt; P-A</td>
<td>6 + PE</td>
</tr>
<tr>
<td>W5</td>
<td>0...±10V</td>
<td>0...+10V &gt; P-A</td>
<td>11 + PE</td>
</tr>
</tbody>
</table>

D_FBobe & D_1FTobe_12-40 5715-644 UK.indd CM 05.06.12
Parker D*FB/D*1FT proportional directional control valves have an integral electronic and requires only one sole electrical common for the control system. Different flow sizes, as well as command signal options are available to achieve an optimal adaption for different applications.

**Name Plate Example**

![Name Plate Example](image)

**Characteristics of Valve Driver**

The described integral electronic driver combines all necessary functions for the optimal operation of the valve. The most important features are:

- digital circuit design
- high dynamic constant current solenoid control
- differential input stage with various command signal options
- four quadrant ramp function
- MIN adjustment for deadband compensation
- MAX adjustment to match the command signal span to the valve operating range
- optional reference outputs +/-10 V for potentiometer supply
- optional four parametrizable preset recall channels
- standard central connection
- compatible to the relevant European EMC-standards
- comfortable interface program

---

**Block Diagram of Integral Electronics**

**Code F0/M0 (6+PE)**

```
command 0...-10V
potentiometer supply +10V
-10V
```

**Code S0/G0 (6+PE)**

```
command S0: 4...12...20mA
G0: 0...±20mA
```

**Code W5 (11+PE)**

```
preset recall S1 S2 S3 S4
command 0...+/-10V
potentiometer supply +10V
-10V
```

---

D_Fbobe & D_1Ftobe_12-40 5715-644 UK.indd CM 05.06.12
## Technical Data

### General

<table>
<thead>
<tr>
<th><strong>Model</strong></th>
<th>Proportional directional control valve, direct operated (D<em>FB), pilot operated (D</em>1FT)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Drive</strong></td>
<td>Proportional solenoid</td>
</tr>
</tbody>
</table>
| **Mounting Pattern** | NG6 (CETOP 3) / NG10 (CETOP 5)  
NG16 (CETOP 7) / NG25 (CETOP 8) |
| **Installation Position** | Any |
| **Hysteresis** |  
D1FB*0/D3FB*0 [%] < 4  
D3FB*3/D*1FT [%] < 5 |
| **Ambient Temperature Range** | -20...+60°C |
| **Protection Class** | NEMA 4 (IP 65) acc. EN 60529 |
| **Vibration Strength** |  
10 Sinus 5...2000 Hz acc. IEC 68-2-6  
30 Random noise 20...2000 Hz acc. IEC 68-2-36  
15 Shock acc. IEC 68-2-27 |
| **Weight** | NG6: 3 / NG10: 7 / NG16: 11 / NG25: 19.5 kg |

### Hydraulic

| **Fluid Rate** | Hydraulic oil acc. DIN 51524...535, other on request |
| **Viscosity** | [SSU] 140...370 |
| **Fluid Temperature** | -20...+60°C |
| **Cleanliness** | Purity level class acc. NAS 1638: class 7 |
| **Operating Pressure max. (D*FB)** | 350 for ports P, A, B / 210 for port T |
| **Pilot oil intern (D*1FT):** | 350 for ports P, A, B, X / 105 for T, Y |
| **Pilot oil extern (D*1FT):** | 350 for ports P, A, B, T, X / 105 for Y |

### Electrical

| **Duty Ratio** | % 100 |
| **Supply Voltage** | Us VDC 18...30, ripple < 5% eff., surge free |
| **Current Consumption max.** | A D1FB: 1.5 / D3FB: 2.0 / D*1FT: 1.5 |
| **Pre-Fusing** | A D1FB: 2.0 / D3FB: 2.5 / D*1FT: 2.0 |
| **Potentiometer supply** | Up V ± 10 / ± 5 % max. 10 mA |
| **Command Signal Options** | Uc V 11 for terminal D and E against 0V (terminal B) |
| **Current** | Ic mA 11 for terminal D and E against 0V (terminal B) |
| **Differential Input Voltage max.** | Code W5: 30 for terminal 4 and 5 against 0V (terminal 2) |
| **Channel Recall Signal** | Uch V 0...2.5: Off / 5...30: On / Ri = 100 kOhm |
| **Adjustment Ranges** | Min % 0...50  
Max % 50...100  
Ramp s 0...32.5 |
| **Interface** | RS 232C, parametrizing connection 5pole |
| **EMC** | EN 61000-6-2, EN 61000-6-4 |
| **Central Connection** | Codes F0, M0, S0, G0: 6 + PE acc. EN 175201-804 |
| **Cable Specification** | Code W5: 11 x 1.0 (AWG16) overall braid shield |
| **Cable Length max.** | m 50 |
Signal flow diagram
Operation Manual

2. Safety Instructions
Please read the operation manual before installation, startup, service, repair or stocking! Paying no attention may result in damaging the valve or incorporated system parts.

Symbols
This manual uses symbols which have to be followed accordingly:

⚠ Instructions with regard to the warranty
⚠ Instructions with regard to possible damaging of the valve or linked system components
👉 Helpful additional instructions

Marking, Name Plates
Instructions applied on the valve, i.e. wiring diagrams and name plates, must be observed and maintained legibly.

Work at the Valve
Workings in the area of installation, commissioning, maintenance and repair of the valve may only be allowed by qualified personnel. This means persons which have, because of education, experience and instruction, sufficient knowledge on relevant directives and approved technical rules.

3. Important Details
Intended Usage
This operation manual is valid for proportional directional control valves D*FB/D*1FT series. Any different or beyond it usage is deemed to be as not intended. The manufacturer is not liable for warranty claims resulting from this.

Common Instructions
We reserve the right for technical modifications of the described product. Illustrations and drawings within this manual are simplified representations. Due to further development, improvement and modification of the product the illustrations might not match precisely with the described valve. The technical specifications and dimensions are not binding. No claim may resulting out of it. Copyrights are reserved.

Liability
The manufacturer does not assume liability for damage due to the following failures:
- incorrect mounting / installation
- improper handling
- lack of maintenance
- operation outside the specifications

⚠ Do not disassemble the valve! In case of suspicion for a defect please return the valve to the factory.

Storage
In case of temporary storage the valve must be protected against contamination, atmospheric exposure and mechanical damages. Each valve has been factory tested with hydraulic oil, resulting in protection of the core parts against corrosion. Yet this protection is only ensured under the following conditions:

<table>
<thead>
<tr>
<th>Storage period</th>
<th>Storage requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>12 months</td>
<td>constant humidity &lt; 60% as well as constant temperature &lt; 25°C</td>
</tr>
<tr>
<td>6 months</td>
<td>varying humidity as well as varying temperature &lt; 35°C</td>
</tr>
</tbody>
</table>

⚠ Outdoor storage or within sea and tropical climate will lead to corrosion and might disable the valve!
4. Mounting / Installation

Scope of Supply
Please check immediately after receiving the valve, if the content is matching with the specified scope of supply. The delivery includes:

- valve
- operation manual

The central connector assembly as well as the parametrizing cable has to be ordered separately and are not included in the delivery.

Please check the delivery immediately after receiving the shipment for apparent damages due to shipping. Report shipment losses at once to the carrier, the insurance company and the supplier!

Mounting

- Compare valve type (located on the name plate) with part list resp. circuit diagram.
- The valve may be mounted fix or movable in any direction.
- Verify the mounting surface for the valve. Uneveness of 0.01 mm/100 mm, surface finish of 6.3 µm are tolerable values.

Keep clean valve mounting surface and work environment!

- Remove protection plate from the valve mounting surface
- Check the proper position of the valve ports and the O-rings.
- Mounting bolts:
  - D1FB: 4 pcs. M5x30
  - D3FB: 4 pcs. M6x40
  - D31FT: 4 pcs. M6x40
  - D41FT: 2 pcs. M6x55 / 4 pcs. M10x60
  - D91FT: 6 pcs. M12x75
  - use property class 12.9, DIN 912

Parker offers bolt kits:
  - D1FB: BK375
  - D3FB: BK385
  - D31FT: BK385
  - D41FT: BK320
  - D91FT: BK360

- Tighten the bolts crisscross with the following torque values:
  - D1FB: 7.6 Nm / D3FB: 13.2 Nm
  - D31FT: 13.2 Nm, D41FT: 13 (63) Nm, D91FT: 108 Nm

Insufficient condition of the valve mounting surface might create malfunction!
Incorrect mounting resp. bolt torque may result in abrupt leakage of hydraulic fluid on the valve ports.

Operation Limits
The valve may be operated within the determined limits only. Please refer to the “technical data” section as well as to the “characteristic curves” in the catalog.

Follow the environmental conditions! Unallowable temperatures, shock load, aggressive chemicals exposure, radiation exposure, illegal electromagnetic emissions may result in operating trouble and may lead to failure!
Follow the operating limits listed in the “specifications” table!

Pressure Fluids
The following rules applies for the operation with various pressure fluids:

The above information serves for orientation and does not substitute user tests among the particular operating conditions. Particularly no liability for media compatibility may be derived out of it.

<table>
<thead>
<tr>
<th>mineral oil</th>
<th>usable without restriction</th>
</tr>
</thead>
<tbody>
<tr>
<td>HFA</td>
<td>oil-in-water emulsion</td>
</tr>
<tr>
<td>HFB</td>
<td>water-in-oil emulsion</td>
</tr>
<tr>
<td>HFC</td>
<td>aqueous solution (glycols)</td>
</tr>
<tr>
<td>HFD</td>
<td>unhydrous fluids (Phosphor-Ester)</td>
</tr>
</tbody>
</table>

For detailed information concerning pressure fluids note VDMA-document 24317 as well as DIN 51524 & 51502.

Special gaskets may be available depending on the utilized fluid.
In case of insecurity please consult the factory.

D_Fobe & D_1FTope_12-40 5715-644 UK.indd CM 05.06.12
Electrical Connection

The electrical connection of the valve takes place by one common cable, which is coupled to the integrated electronic driver by a central connector assembly.

The connection Codes F0/S0 requires a 6 + PE female connector EN 175201-804.

The female connector has to be ordered separately under article nr. 5004072.

A female connector with metal housing is required! Plastic made models may create function problems due to insufficient EMC-characteristics.

The connecting cable has to comply to the following specification:

- **Cable type**: control cable, flexible, 7 conductors, overall braid shield
- **Cross section**: min. AWG16/1.0 mm²
- **Outer dimension**: 8...12 mm
- **Cable length**: max. 50 m

For cable lengths > 50 m consult factory.

The connection cable is coupled to the female connector by solder joints.

Skinning lengths for the connecting cable:

5 35 15

For the workmanlike termination of the crimp contacts the tool # 932 507-001 – supplier: Hirschmann – is required.

Do not disconnect cable socket under tension!
Electrical Interfacing

Supply Voltage:
The supply voltage for the valve has to cover the range of 18...30 V. The residual ripple may not exceed 5% eff.

⚠️ The applied power supply must comply to the relevant regulations (DIN EN 61558) and must carry a CE-mark. The operating voltage for the valve must be free of inductive surges. Do not exceed the max. value of 30V! Non-observance of this rule may result in permanent damaging of the valve.

⚠️ The increased inrush current of the valve should be considered when selecting the power supply. A stabilized power supply with overcurrent limiting feature should not be used. Due to the inrush current of the valve the current limit circuit may respond prematurely and create problems during energizing of the supply voltage.

⚠️ The operation of the valve is blocked if the supply voltage polarity is interchanged.

⚠️ Each valve requires a separate pre-fuse (rating: s. techn. data). Non-observance of this instruction may create irreparable damage of valve resp. incorporated system parts.

The backshell nut of the cable gland has to be tighten with a suitable tool. The target value for the tightening torque is 4 Nm. Tighten the cap nut with a torque of approx. 5 Nm after attaching the female connector on the socket outlet.

⚠️ Incomplete tightening of backshell nut resp. cap nut may result in automatic release of the connection as well as degradation of the water tightness. Follow the “instructions for use” for installation of female connectors made by other kind of brands!

⚠️ The cable connection to the female connector has to take place by qualified personnel! A short between individual conductors resp. to the connector housing, bad soldering as well as improper shield connection may result in malfunction and breakdown of the valve.

⚠️ The mounting surface of the valve has to be carefully tied to the earth grounded machine frame. The earth ground wire from the valve connecting cable as well as the cable shield have to be tied to the protective earth terminal within the control unit. It is necessary to use a low ohmic potential connection between control unit and machine frame to prevent earth loops (cross section AWG 6).
Wiring diagram of supply voltage
Code F0/M0/S0/G0 (6 + PE)

Incorrect signal amplitude levels may disturb the functionality and can damage the valve.

The option 4...20 mA uses the "0 mA" condition as breakdown-information. This means the presence of an evaluable failure information if the input signal line is interrupted. In this case the actuator drive will be switched off. The drive will switch on when the input signal reaches a value of 3.8 mA, it switches off when the command falls below 3.6 mA. This determination follows the NAMUR-specification NE43.

NAMUR is an association of users of process control technology.

Command signal input:
The command signal for the valve will be connected to the difference signal input of the electronic driver. The solenoid current behaves proportional to the command signal amplitude. Different versions of command signal processing are available, depending on the valve type. These are described below:
For the function description is assumed as signal reference (0V):
Code F0/M0/S0/G0: pin E, Code W5: pin 5

Details are shown from the technical specifications.

The command input signal needs to be filtered as well as free of inductive surges and modulations. Due to the sensitivity of the valve a high signal quality is recommended, this will prevent malfunction.
Wiring diagram of voltage command input +10...0...-10 V Code F0/M0 (6 + PE)

The external potentiometer is fed via the output “potentiometer supply”. To prevent this output from overload, the resistance value of the potentiometer should be within a range of 5...10 kOhm. A nominal power rating of 0.1 W is sufficient.
Wiring diagram of voltage command input +10...0...-10 V
Code W5 (11 + PE)

Wiring diagram of voltage command input +10...0...-10 V via potentiometer
Code W5 (11 + PE)

Wiring diagram of current command input +20...0...-20 mA Code G0 (6+PE)
Wiring diagram of current command input 4...12...20 mA
Code S0 (6 + PE)

command signal

control system

valve

command signal

function

command signal

function

Wiring diagram of current command input 4...12...20 mA
Code W5 (11 + PE)

command signal

control system

valve

command signal

function

command signal

function
Recall channels for internal command preset

Up to six corresponding inputs are provided for channel recall of internal command presets. The conjunction options of the internal command channels may be selectable via the parameter E21. The following options are provided:

- priority dependent
- additive

At priority dependent channel recall the channel with the lowest numerical designation has priority against other simultaneously addressed preset channels.

Example: Channels S1, S2, S3 are addressed. Channel S1 has priority, the corresponding internal command will be assessed as input signal.

The preset channels have priority against the analog signal input for the external command.

At additive channel recall the internal signal presets of the recall channels as well as a possible signal at the external signal input will be added. The sum of the signal values is limited at 100%.

Example 1: Channel S1 = +50%, channel S2 = +20%, external input signal = +5V (= +50%). The sum is +120%, in this case +100% input signal will be assessed.

Example 2: Channel S1 = +50%, channel S2 = +20%, external input signal = -5V (= -50%). The sum is +20%, in this case +20% input signal will be assessed.

The preset channels are switched through during the signal trigger at the dedicated inputs.

More details are shown from the technical data.

The channel recall signals need to be filtered as well as free of inductive surges and modulations. To prevent malfunctions a high signal quality is recommended.

Wiring diagram of recall channels

Code W5 (11 + PE)
5. Operating Instructions

Basically the valve performs the task of converting a command signal into a proportional spool stroke with the highest possible dynamic. For these purposes the input value will be electronically processed and provides via a power amplifier stage the required current for the valve solenoid.

ProPxD parameterizing software:

The ProPxD software permits comfortable parameter setting for the module electronic. Via the clearly arranged entry mask the parameters can be noticed and modified. Storage of complete parameter sets to floppy or hard disk is possible as well as printout or record as a text file for further documentation. Stored parameter sets may be loaded anytime and transmitted to other valves. Inside the electronic a nonvolatile memory stores the data with the option for recalling or modification.

Features

• comfortable editing of all parameters
• depiction and documentation of parameter sets
• storage and loading of optimized parameter adjustments
• executable with all actual Windows® operating systems from Windows® 95 upwards
• plain communication between PC and electronic via serial interface RS-232.

Comfortable interface, see Parker freeware available from infohcd@parker.com.

Hardware requirements

• PC with operating system from Windows® 95 upwards
• Interface RS-232
• display resolution min. 800 x 600
• connection cable between PC and electronic module
• storage requirement approx. 4 MB

☞ It is recommended to select “small fonts” at the display setting, otherwise distortion of the display may occur.

Cable Specification

The connection of the valve electronic to a PC requires a special cable. It may be ordered under code 40982923. The cable has to be inserted between an unused serial port COM1 or COM2 of the PC and the 5pole socket connector of the valve electronic (parametrizing connector).

☞ Before connecting of the parametrizing cable a cover plug has to be removed from the electronic housing.

⚠ Attention! The valve electronic provides no USB interface, but can only be parametrized via an RS-232 - connection. Therefore the usage of USB standard cables is permitted and may result in damaging of valve resp. PC.
Parametrizing connection

Parametrizing cable 40982923

The cover plug has to be re-installed after completion of the parametrizing work.

Program installation

Please check before installation if the above hardware requirements are met. If your PC has already stored an older version of the “ProPxD” program, it has to be deinstalled by using the Windows® system control feature.

Program installation sequence:
• terminate the execution of other programs
• insert ProPxD-software CD
• execute the file “setup.exe”
• follow the instructions on the screen

Answer the question, if an older version should be overwritten, with “ok”. During the installation you may change destination drive resp. installation path, if needed (i.e. if the storage space on drive “c” is not sufficient).

Please answer also “ok” if at the end of the installation the program reports any system information. After successful installation the desktop display shows the ProPxD icon for starting the program.

Software Operating

Brief instruction for first startup:
• Connect the valve electronic to the supply voltage.
• Connect the valve electronic to a PC via the parametrizing cable.
• Click on the ProPxD icon to start the operating program.
• After displaying the program resp. data base version a program window opens and the connected valve will be automatically identified (possibly a manual identification via the button “Receive all” is necessary).
• Select the desired version via the menu “Options/Optionen” with the menu item “Language/Sprache”.
• The valve specific default parameters are already available within the parameter table.
• Individual parameters may be selected via mouse or the arrow buttons at the center of the program screen.
Parameter changes are possible via mouse or the arrow buttons on the bottom left within the program screen, also the parameter values may be edited via the keyboard.

Modified parameters will be stored via the “Enter” key or via the button “Update list”.

After completing of all modifications, the entire parameter set may be transmitted to the valve via the button “send all”, also the parameters will be nonvolatile stored.

The chosen parameters may be optionally stored on the PC via the “File”-menu with the menu item “Save as”, data retrieving is always possible via the function “Load out of database”.

Extended functions:
The user software is shared into 2 parameter ranges:
- basic mode
- expert mode

For normal startup the basic mode is absolutely sufficient. It permits the setting of all application specific parameters to match the valve function with the task setting.

In case of special applications the valve parameters may be adapted via the expert mode.

The operating mode may be selected from the “Options”-menu and remains after terminating and re-start of the program.

Changing of expert parameters is only permitted for qualified personnel. Incorrect settings may lead to malfunction! In case of parameter changes shut the drive down!

To prevent an unauthorized access for the expert mode, a pass word is requested. The name is “parker” and cannot be changed. Thus additionally to the button “Default” for loading of the default parameters, the button “Send parameter” appears in the “Expert”-operating mode. This button transmits only the setting of one single parameter to the connected valve. Thus a quick tuning of single parameters is permitted during the setup.

A horizontal bar graph readout between the communication buttons shows the data transfer state.

Because the ProPxD program has also offline (i.e. without connection to the valve) functionality, a manual pre-selection of the parameters is possible. After selection of the valve type via the menu “Options” the parameters may be set and stored for later transmission. Note the design series while selection of the valve!

The “File” menu provides the functions “Printer setup”, “Print preview” and “Print”. The print preview includes the option for parameter set storage as text file (format .txt) prior to further processing. The “Options” menu provides also the selection of the RS-232 interface port via the menu item “Port”. Via the menu item “Load out of database” previously stored parameter sets may be loaded.

Adjustment parameters
The available parameters may be divided into multiple groups and are characterized by different letters:
- S-parameters
- P-parameters
- E-parameters
### Parameter overview for basic mode

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
<th>Parameter Range</th>
<th>Default Setting</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>internal Sollwert S1</td>
<td>%</td>
<td>-100 to 100</td>
<td>0.0</td>
<td>code W5 only</td>
</tr>
<tr>
<td>S2</td>
<td>internal Sollwert S2</td>
<td>%</td>
<td>-100 to 100</td>
<td>0.0</td>
<td></td>
</tr>
<tr>
<td>S3</td>
<td>internal Sollwert S3</td>
<td>%</td>
<td>-100 to 100</td>
<td>0.0</td>
<td></td>
</tr>
<tr>
<td>S4</td>
<td>internal Sollwert S4</td>
<td>%</td>
<td>-100 to 100</td>
<td>0.0</td>
<td></td>
</tr>
<tr>
<td>S5</td>
<td>ramp accel. channel A</td>
<td>ms</td>
<td>0 to 32500</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>S6</td>
<td>ramp decel. channel A</td>
<td>ms</td>
<td>0 to 32500</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>S7</td>
<td>ramp accel. channel B</td>
<td>ms</td>
<td>0 to 32500</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>S8</td>
<td>ramp decel. channel B</td>
<td>ms</td>
<td>0 to 32500</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>P3</td>
<td>MAX channel A</td>
<td>%</td>
<td>50.0 to 100.0</td>
<td>100.0</td>
<td></td>
</tr>
<tr>
<td>P4</td>
<td>MAX channel B</td>
<td>%</td>
<td>50.0 to 100.0</td>
<td>100.0</td>
<td></td>
</tr>
<tr>
<td>P7</td>
<td>MIN channel A</td>
<td>%</td>
<td>0.0 to 50.0</td>
<td>0.0</td>
<td></td>
</tr>
<tr>
<td>P8</td>
<td>MIN channel B</td>
<td>%</td>
<td>0.0 to 50.0</td>
<td>0.0</td>
<td></td>
</tr>
<tr>
<td>P11</td>
<td>polarity command</td>
<td>–</td>
<td>0 to 1</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>E17</td>
<td>option command</td>
<td>–</td>
<td>1 = ±10V</td>
<td>1 = ±10V</td>
<td>code W5 only</td>
</tr>
<tr>
<td>E19</td>
<td>cable break detection command</td>
<td>–</td>
<td>0 = ±10V</td>
<td>0 = +/-10V</td>
<td>codes S0 &amp; W5</td>
</tr>
<tr>
<td>E25</td>
<td>MIN operating threshold</td>
<td>–</td>
<td>0 = 1%</td>
<td>0 = 1%</td>
<td></td>
</tr>
</tbody>
</table>
### Individual Description of Basic Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description and Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>S1</strong> command signal S1</td>
<td>Adjustment of the internal command signal channel S1. To attenuate of an external accessible command signal.</td>
</tr>
<tr>
<td><strong>S2</strong> command signal S2</td>
<td>Adjustment of the internal command signal channel S2. To attenuate of an external accessible command signal.</td>
</tr>
<tr>
<td><strong>S3</strong> command signal S3</td>
<td>Adjustment of the internal command signal channel S3. To attenuate of an external accessible command signal.</td>
</tr>
<tr>
<td><strong>S4</strong> command signal S4</td>
<td>Adjustment of the internal command signal channel S4. To attenuate of an external accessible command signal.</td>
</tr>
<tr>
<td><strong>S5</strong> ramp accel. channel A</td>
<td>Adjustment of ramp rate for increasing of the positive signal polarity. To avoid switching noise.</td>
</tr>
<tr>
<td><strong>S6</strong> ramp decel. channel A</td>
<td>Adjustment of ramp rate for decreasing of the positive signal polarity. To avoid switching noise.</td>
</tr>
<tr>
<td><strong>S7</strong> ramp accel. channel B</td>
<td>Adjustment of ramp rate for increasing of the negative signal polarity. To avoid switching noise.</td>
</tr>
<tr>
<td><strong>S8</strong> ramp decel. channel B</td>
<td>Adjustment of ramp rate for decreasing of the negative signal polarity. To avoid switching noise.</td>
</tr>
<tr>
<td><strong>P3</strong> MAX +</td>
<td>Adjustment of maximum signal span for positive output signal. To match the command signal span to the valve operating range.</td>
</tr>
<tr>
<td><strong>P4</strong> MAX -</td>
<td>Adjustment of maximum signal span for negative output signal. To match the command signal span to the valve operating range.</td>
</tr>
<tr>
<td><strong>P7</strong> MIN +</td>
<td>Adjustment for positive output signal step at 0,1% command signal. To compensate for the overlap of the valve spool.</td>
</tr>
<tr>
<td><strong>P8</strong> MIN -</td>
<td>Adjustment for negative output signal step at 0,1% command signal. To compensate for the overlap of the valve spool.</td>
</tr>
<tr>
<td><strong>P11</strong> command signal polarity</td>
<td>Adjustment of the command signal polarity. To match the command signal polarity to the valve operating direction.</td>
</tr>
<tr>
<td><strong>E17</strong> type of command signal device</td>
<td>Adjustment of the command signal option. To match the command signal input to the input signal mode.</td>
</tr>
<tr>
<td><strong>E19</strong> cable break detection command</td>
<td>Adjustment of the operating mode for the command cable break detection. To turn on resp. off of the cable break detection of the command signal at a selected command signal option of 4...20 mA.</td>
</tr>
<tr>
<td><strong>E25</strong> MIN operating threshold</td>
<td>Adjustment of the MIN operating threshold. To match the response sensitivity for the MIN-stroke step.</td>
</tr>
</tbody>
</table>
### Parameter overview for expert mode

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
<th>Parameter Range</th>
<th>Default Setting</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>S11</td>
<td>ramp for int. command S1</td>
<td>ms</td>
<td>0 to 32500</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>S12</td>
<td>ramp for int. command S2</td>
<td>ms</td>
<td>0 to 32500</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>S13</td>
<td>ramp for int. command S3</td>
<td>ms</td>
<td>0 to 32500</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>S14</td>
<td>ramp for int. command S4</td>
<td>ms</td>
<td>0 to 32500</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>S17</td>
<td>default ramp</td>
<td>ms</td>
<td>0 to 32500</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>P5</td>
<td>dither amplitude</td>
<td>%</td>
<td>0 to 10.0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>P6</td>
<td>dither frequency</td>
<td>Hz</td>
<td>0 to 300</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>E21</td>
<td>option internal command signal conjunction</td>
<td>–</td>
<td>0 = priority dependent, 1 = additive</td>
<td>0 = priority dependent</td>
<td>Code W5 only</td>
</tr>
<tr>
<td>E22</td>
<td>int. command signal ramp function</td>
<td>–</td>
<td>0 = quadrant dependent (S5...8), 1 = int. command depend. (S11...14)</td>
<td>0 = quadrant dependent</td>
<td></td>
</tr>
<tr>
<td>E83</td>
<td>int. command signal functionality</td>
<td>–</td>
<td>0 = standard, 1 = special option DFL</td>
<td>0 = standard</td>
<td></td>
</tr>
</tbody>
</table>

### Individual Description of Expert Parameters

- **S11 ramp for internal command signal 1**: Adjustment of the ramp rate for the internal command signal channel S1. To avoid switching noise.
- **S12 ramp for internal command signal 2**: Adjustment of the ramp rate for the internal command signal channel S2. To avoid switching noise.
- **S13 ramp for internal command signal 3**: Adjustment of the ramp rate for the internal command signal channel S3. To avoid switching noise.
- **S14 ramp for internal command signal 4**: Adjustment of the ramp rate for the internal command signal channel S4. To avoid switching noise.
- **S17 default ramp**: Adjustment of the ramp rate for the default ramp. To avoid switching noise.
- **P5 dither amplitude**: Adjustment of dither amplitude. To reduce the influence of solenoid friction.
- **P6 dither frequency**: Adjustment of dither frequency. To match the dither signal to the valve dynamic.
- **E21 internal command signal conjunction**: Adjustment of the conjunction for the internal command signals. To match the command signal logic.
- **E22 internal command signal ramp function**: Adjustment of the ramp function for the internal command signals. To match the ramp functionality.
- **E83 internal command signal functionality**: Adjustment of the functionality for the internal command signals. To match for the special option DFL.
Error messages

Malfuctions when using the ProPxD software program will be indicated via appropriate failure messages.

Failure messages and corrective actions:

<table>
<thead>
<tr>
<th>Failure message</th>
<th>Description/corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Com Port is not available!</td>
<td>Terminate the other program, or quit the message and select another RS-232 port via the menu “Options &gt; Port”. Afterwards reconnect the parametrizing cable.</td>
</tr>
<tr>
<td>Unable to open COM port</td>
<td>Com port is not available. Quit the message and select another RS-232 port via the menu “Options &gt; Port”. Afterwards reconnect the parametrizing cable.</td>
</tr>
<tr>
<td>There is no module/valve connected or the communication is disturbed! Please check also the interface!</td>
<td>No data exchange possible. Either the electronic has been removed, the port is mismatched, or the connection will be disturbed by strong electrical fields. Check if the Com port is set for “9600, 8, 1, none, none” via the menu “Options &gt; Port”.</td>
</tr>
<tr>
<td>Wrong password</td>
<td>Retype the password, notice the exact spelling (case sensitivity).</td>
</tr>
<tr>
<td>Wrong input</td>
<td>An unvalid character or a value outside the permitted range has been used at parameter entry.</td>
</tr>
<tr>
<td>Keep the entered parameters?</td>
<td>During parameter loading from the electronics memory the preset parameters from the left hand screen display may be rejected or maintained.</td>
</tr>
<tr>
<td>The chosen module/valve isn’t the same as the connected hardware. Attention! Unsaved parameters will be lost.</td>
<td>In principle, parameters dedicated to a type which deviates from the connected valve may be edited. However, for data transmitting the correct valve has to be connected. If parameters will be loaded from a valve which deviates from the selected one, the parameters from the left hand side screen display of the program will be overwritten.</td>
</tr>
<tr>
<td>The chosen hardware isn’t the same as the connected module/valve.</td>
<td>The wrong valve type has been selected from the database, afterwards the function “send all” has been executed.</td>
</tr>
<tr>
<td>Attention! Factory settings will be changed! Transmit anyhow?</td>
<td>Default parameters has been read out from the database instead from the valve via the function “receive all”.</td>
</tr>
<tr>
<td>file name.pxd already exists. Do you want to replace the file?</td>
<td>The file name already exists within the indicated directory. Select another name, another directory or overwrite the existing file with “OK”.</td>
</tr>
</tbody>
</table>
Air Bleeding of Hydraulic System

During initial startup, after an oil change as well as after the opening of lines or valves the hydraulic system must be air bled. Air in the hydraulic system is very disadvantageous and therefore undesirable for the control system. The pipeline network is vented at its highest point. The fitting may be loosened a little so that the air can escape with only a small amount of oil loss. When the oil is no longer foaming, the fitting is re-tightened. Afterwards all functions are run through, one after the other, in no-load operation with low pressure and with full cylinder stroke. Afterwards the system should be vented once more.

⚠️ After air bleeding the oil level in the tank must be checked, and refilled as necessary!

Filter

The function and lifetime of the valve are strongly affected by the cleanliness of the fluid.

⚠️ Dirt is the greatest enemy of the hydraulic system!

There are three important sources of dirt to watch for:

- contamination arising during installation
- contamination arising during operation, friction wear
- impurities from the environment

Basically a purity level class of 7 acc. NAS 1638 is required.

🔍 Pay attention to maintenance details!

Flushing

It is recommended to flush the long pipelines by short circuiting the pressure and return lines, especially for large, central pressure oil stations. This prevents the installation dirt from entering the valve.

6. Maintenance

⚠️ Service work may only be carried out by qualified personnel. Detailed knowledge of the machine functions concerning switching on and off as well as of the required safety relevant technical tasks is required!

Periodical maintenance is essential for the longevity of the system and guarantees reliability and availability. The following properties of the system has to be checked in continuous short time intervals:

- oil level in the tank
- max. working temperature
- condition of the pressure fluid (visual inspection, colour and smell of hydraulic fluid)
- working pressure levels
- gas pre-load pressure on the pressure accumulator
- leakage on all system components
- condition of filter elements
- condition of hose lines
- cleanliness of components

After a certain operating duration a change of the hydraulic fluid is required. The frequency of change depends from the following circumstances:

- kind resp. grade of the pressure fluid
- filtering
- operating temperature and environmental conditions
7. Trouble Shooting

Basis of troubleshooting is always a systematic approach. At first the following questions have to be checked:

- Are there practical experiences with similar failures?
- Have system adjustments been changed?

Afterwards starting of troubleshooting by means of a priority list of the most likely reasons.

For suspect of a sluggish spool the valve may be flushed with clean pressure fluid.

Troubleshooting in a hydraulic system requires in either case a systematic approach. The work may exclusively be performed by qualified personnel, as it requires detailed knowledge about function and construction of the system. Reversals or disassemblies may not be taken imprudently! Prior to the works it has to be clarified, if the system has been operated properly until the failure occurred.

<table>
<thead>
<tr>
<th>malfunction at hydraulic load runtime</th>
</tr>
</thead>
<tbody>
<tr>
<td>- generally no function</td>
</tr>
<tr>
<td>- high frequent oscillation</td>
</tr>
<tr>
<td>- low frequent oscillation</td>
</tr>
<tr>
<td>- one way operation only</td>
</tr>
<tr>
<td>- speed variations at unchanging command</td>
</tr>
<tr>
<td>- different speeds depending on travel direction</td>
</tr>
<tr>
<td>- speed too low</td>
</tr>
<tr>
<td>possible reasons for malfunction</td>
</tr>
<tr>
<td>hydraulic pump resp. motor defective</td>
</tr>
<tr>
<td>drive overloaded</td>
</tr>
<tr>
<td>valve contaminated</td>
</tr>
<tr>
<td>hydraulic fluid too viscous / too cold</td>
</tr>
<tr>
<td>too low oil level within tank</td>
</tr>
<tr>
<td>filter contaminated</td>
</tr>
<tr>
<td>supply voltage too low</td>
</tr>
<tr>
<td>supply voltage carries too much ripple</td>
</tr>
<tr>
<td>command signal too low</td>
</tr>
<tr>
<td>command signal carries too much ripple</td>
</tr>
<tr>
<td>dither signal amplitude too high</td>
</tr>
<tr>
<td>dither signal amplitude too low</td>
</tr>
<tr>
<td>central connector contact failure</td>
</tr>
<tr>
<td>feed cable interrupted</td>
</tr>
<tr>
<td>wiring sequence incorrect</td>
</tr>
<tr>
<td>feed cable without shielding</td>
</tr>
<tr>
<td>pilot flow configuration incorrect</td>
</tr>
</tbody>
</table>

*) only for D*1FT
8. Accessories / Spare Parts

Accessories

The following accessories are available for the valves series D*FB/D*1FT:

**D1FB:**
- Bolt kit ordering code BK375
- Code F0/M0/S0/G0: female connector 6+PE ordering code 5004072
- Code W5: female connector 11+PE ordering code 5004711

**D3FB:**
- Bolt kit ordering code BK385
- Code F0/M0/S0/G0: female connector 6+PE ordering code 5004072
- Code W5: female connector 11+PE ordering code 5004711

**D31FT:**
- Bolt kit ordering code BK385
- Code F0/M0/S0/G0: female connector 6+PE ordering code 5004072
- Code W5: female connector 11+PE ordering code 5004711

**D41FT:**
- Bolt kit ordering code BK320
- Code F0/M0/S0/G0: female connector 6+PE ordering code 5004072
- Code W5: female connector 11+PE ordering code 5004711

**D91FT:**
- Bolt kit ordering code BK360
- Code F0/M0/S0/G0: female connector 6+PE ordering code 5004072
- Code W5: female connector 11+PE ordering code 5004711

**Spare Parts**

The following spare parts are available:

**D1FB:**
- Seal kit NBR ordering code SK-D1FB-N

**D3FB:**
- Seal kit NBR ordering code SK-D3FB-N

**D31FT:**
- Seal kit NBR ordering code SK-D31FTN

**D41FT:**
- Seal kit NBR ordering code SK-D41FTN

**D91FT:**
- Seal kit NBR ordering code SK-D91FTN